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PROGRAMMATORE  USB 
PER DISPOSITIVI PIC FLASH

FT65xK: versione in kit
FT65xM: versione già montata

1. CARATTERISTICHE E SPECIFICHE

Programmatore USB per PIC Microchip adatto a tutti i microcontrollori Flash delle famiglie 10,
12, 16 e 18 (vedi elenco) caratterizzato da dimensioni p articolarmente ridotte. 
La connessione USB al PC consente di velocizzare l’operazione di programmazione e di alimen-
tare direttamente l’unità. 
Il dispositivo offre la possibilità di ef fettuare la programmazione in-circuit ed anche tramite zoccolo
textool o zoccoli tradizionali (utilizzando le apposite schede di esp ansione FT651 e FT652). 

Caratteristiche 

- Possibilità di programmazione: ICSP™ (In-Circuit Serial Programming™) 
con scheda textool 40 pin (cod. FT652)
con scheda zoccoli (cod. FT651)

- Collegamento tramite porta USB
- Semplice sof tware di programmazione PICKit2 (V .1.20 scaricabile gratuit amente dal sito

www.microchip.com)

FT650

FT652

FT651
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Specifiche

- Alimentazione: prelevata direttamente dalla porta USB
- Collegamento con PC: tramite cavo USB (A-B maschio)
- Dimensioni: scheda unità principale (FT650) 64 x 53 mm

scheda zoccoli (FT651) 64 x 68 mm
scheda zoccolo textool (FT652) 64 x 52 mm

- Microcontrollori supportati: 
PIC10F200, 202, 204, 206 
PIC10F220, 222 
PIC16F54, 57, 59 
PIC12F508, 509, 510 
PIC16F505, 506
PIC12F629, 635, 675 
PIC16F616, HV616 
PIC16F627A, 648A
PIC16F630, 636, 676, 
PIC16F684, 685, 687, 688 
PIC16F689, 690, 785 
PIC16F913, 914, 916, 917 
PIC16F946 
PIC16F73, 74, 76, 77 
PIC16F818, 819 
PIC16F873A, 874A, 876A, 877A

PIC18F1220, 2220, 4220 
PIC18F1320, 2320, 4320 
PIC18F2221, 2321, 4221, 4321 
PIC18F2410, 2420, 2455, 2480 
PIC18F2510, 2520, 2525, 2550, 2580, 2585 
PIC18F2610, 2620, 2680 
PIC18F4410, 4420, 4455, 4480 
PIC18F4510, 4515, 4520, 4525, 4550, 4580, 4585 
PIC18F4610, 4620, 4680

Requisiti minimi di sistema

- PC IBM compatibile, Pentium o superiore
- Sistema operativo Windows 98SE/ME/NT/2000/XP
- CDROM drive
- Porta USB libera

2. ASSEMBLAGGIO

I suggerimenti di seguito riportati, sono un aiuto per ottenere un corretto assemblaggio del kit; si
prega di leggerli con attenzione. 
Una scarsa cura nel montaggio del Kit può creare dei problemi di funzionamento.
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2.1 Attrezzatura necessaria

- Si consiglia di utilizzare un saldatore di media potenza (25 - 40 W)
avente una punta da 1 mm. 

- Mantenere la punt a del saldatore ben pulit a, tramite una spugna
inumidita con acqua.  Per poter ottenere delle saldature di qualità e
salvaguardare la punta, è necessario che essa sia sempre ben sta-
gnata. Le saldature devono essere "calde", ossia lo stagno si deve
diffondere uniformemente su tutt a la piazzola present ando una
superficie lucida. 

- Utilizzare stagno avente al suo interno del buon disossidante (non
utilizzare paste disossidanti!).

- Per recidere i reofori dei componenti, servirsi di un tronchesino per
elettronica, prestando attenzione agli occhi perchè, durante il taglio,
i reofori vengono proiettati a distanza.

- Utilizzare una pinza a becchi fini per piegare reofori o per posizio-
nare alcuni componenti.

- Munirsi di un taglierino di piccole dimensioni e di cacciaviti con misure st andard.

- Per l’operazione di taratura, è necessario l’utilizzo di un multimetro digit ale.

2.2 Suggerimenti per l'assemblaggio: 

- Per evitare delusioni, assicurarsi che il grado di dif ficoltà sia compatibile con le proprie capa-
cità ed esperienza.

- Seguire attentamente le istruzioni; leggere e capire ogni p asso prima di operare. 
- L'assemblaggio deve essere eseguito procedendo secondo l'ordine descritto nel manuale.
- Collocare, sul circuito st ampato, ogni singolo componente come mostrato nel piano di 

montaggio. 
- I valori riportati nello schema elettrico, possono essere soggetti a variazioni.
- Utilizzare le tabelle di controllo per prendere nota del proprio avanzamento.

2.3 Suggerimenti per la saldatura

1- Montare tutti i componenti tenendo il loro corpo aderente al circuito
stampato, quindi saldare con cura i relativi terminali. 

2- Assicurarsi che le saldature siano lucide e di forma conica.
3- Rimuovere le eccedenze di st agno per evit are cortocircuiti con le

piazzole adiacenti.
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3. REALIZZAZIONE SCHEDA UNITÀ PRINCIPALE (FT650)

Si consiglia di procedere con il mont aggio dei componenti sul circuito st ampato siglato S650 
secondo la sequenza di seguito riportata:

Nota: per poter far aderire il corpo del connettore strip femmina al circuito st ampato, i relativi pin
devono essere piegati a 90° mediante una pinzett a.  

Il piano di mont aggio della scheda ed il relativo schema elettrico, sono riport ati nella p agina
seguente.

2. Resistenze e trimmer

- R1: trimmer 4,7 kohm MO
- R2: 10 kohm
- R3: 0,22 ohm
- R4: 10 ohm
- R5: 1 kohm
- R6: 10 kohm
- R7: 10 kohm
- R8: 10 kohm
- R9: 10 kohm
- R10: 10 kohm
- R11: 2,2 kohm
- R12: 18 kohm
- R13: 470 ohm
- R14: 470 ohm
- R15: 100 kohm
- R16: 10 kohm
- R17: 10 kohm
- R18: 10 kohm
- R19: 10 kohm

5. Condensatori

- C1: 100 µF 16 VL elettrolitico
- C2: 470 pF ceramico
- C3: 470 µF 16 VL elettrolitico
- C4: 100 nF multistrato
- C5: 100 nF multistrato
- C6: 470 µF 16 VL elettrolitico
- C7: 15 pF ceramico
- C8: 15 pF ceramico

Prestare attenzione alla polari-
tà dei condensatori elettrolitici!

6. Zoccoli per C.I.

- Zoccolo 4+4
- Zoccolo 14+14

Rispettare l'orient amento
della tacca di riferimento!

7. Transistor

- T1: BC557
- T2: BC557
- T3: BC547

Per il corretto mont aggio,  aiu-
tarsi con la serigrafia.

1. Diodi

- D1: 1N5819

Prestare attenzione alla 
polarità! 9. Diodi LED

- LD1: led 5 mm verde
- LD2: led 5 mm rosso

Prestare attenzione alla 
polarità!
Per il corretto montaggio, fare
riferimento alla serigrafia.

11. Circuiti integrati

- U1: MC33063A
- U2: PIC18F2550 (MF650)

Inserirli nei relativi zoccoli
rispettando l’orientamento!

4. Connettore strip 

- PROG: Strip F. 90° 7 pin

10. Connettore USB 

- Connettore USB/B

8. Quarzo

- Q1: quarzo 20 MHz

3. Induttore

- L1: Induttanza 120 µH



MONTAGGIO E UTILIZZO FT650 - FT651 - FT652

5

3.1. Piano di montaggio unita’ principale (FT650)

3.2. Schema elettrico unita’ principale (FT650)
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4. REALIZZAZIONE SCHEDA ZOCCOLI (FT651)

Procedere con il mont aggio dei componenti sul circuito st ampato siglato S651 
secondo la sequenza di seguito riportata:

Nota: per poter far aderire il corpo del connettore strip femmina al circuito st ampato, i relativi pin
devono essere piegati a 90° mediante una pinzett a.  

Di seguito è riportato il piano di montaggio della scheda.

4.1. Piano di montaggio scheda zoccoli (FT651)

2. Zoccoli per C.I.

- Zoccolo 4+4 (2 pz.)
- Zoccolo 7+7
- Zoccolo 9+9
- Zoccolo 14+14
- Zoccolo 20+20 passo doppio

Rispettare l'orient amento
della tacca di riferimento!

3. Connettori pin strip 

- PROG OUT: Strip F. 90° 7 pin
- PROG IN: Strip M. 90° 7 pin

1. Ponticelli

- J1 e J2

Suggerimento: per ottenere dei
ponticelli uniformi, inserire un
capo dello spezzoncino di con-
duttore in rame  nel primo foro,
quindi saldarlo. Ora inserire l’al-
tro capo nel secondo foro e, tra-
mite una pinza, tiratelo delicata-
mente finchè il filo non risult a
aderente al PCB; ef fettuare la
saldatura di quest’altro capo.

J1

IN OUT

J2



4.2. Schema elettrico scheda zoccoli (FT651)

5. REALIZZAZIONE SCHEDA ZOCCOLO TEXTOOL (FT652)

Si consiglia di procedere con il mont aggio dei componenti sul circuito st ampato siglato S652
secondo la sequenza di seguito riportata:

Nota: per poter far aderire il corpo del connettore strip femmina al circuito st ampato, i relativi pin
devono essere piegati a 90° mediante una pinzett a.  

Il piano di mont aggio della scheda ed il relativo schema elettrico, sono riport ati nella p agina
seguente.
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2. Connettori pin strip 

- PROG OUT: Strip F. 90° 7 pin
- PROG IN: Strip M. 90° 7 pin

3. Zoccolo textool

- Textool 20+20

1. Resistenze

R1: 10 kohm
R2: 10 kohm
R3: 10 kohm
R4: 10 kohm
R5: 10 kohm
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5.1. Piano di montaggio scheda zoccolo textool (FT652)

5.2. Schema elettrico scheda zoccolo textool (FT652)

IN OUT
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5.3. Realizzazione flat cable

Il kit viene fornito completo di 1 connettore strip  5
poli maschio, uno femmina ed uno spezzone di
flat cable; un capo di quest’ultimo, dovrà essere
saldato al connettore maschio utilizzando dei
tubetti di guaina termorestringente per isolare le
saldature, mentre l’altro al connettore femmina
rispettando la pin out della scheda su cui è mon-
tato il microcontrollore che si vuole programmare. 

6. COLLEGAMENTO E TARATURA

6.1. Collegamento

Dopo aver completato la realizzazione del programmatore FT650 e delle relative schede port a zoc-
colo, è possibile collegare il dispositivo ad una port a USB libera del personal computer , tramite un
cavo USB standard con connettori A/B maschio (negli zoccoli non deve trovarsi alcun PIC da pro-
grammare). Questo programmatore utilizza un'interfaccia USB HID nativa pertanto viene direttamen-
te riconosciuto da qualsiasi sistema Microsoft Windows a partire dalla versione 98SE. Se si conside-
ra un PC dotato di sistema operativo XP SP2 compariranno due pop-up in sequenza, uno riport an-
te la descrizione ECONO-PIC e l'altro che informa che è stata trovata una nuova periferica USB HID.

Aprire la finestra gestione periferiche, e verificare che il nuovo dispositivo sia st ato correttamen-
te installato   come mostrato dalla seguente immagine:
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Nelle Proprietà->Dettagli della periferica compatibile HID vi dovranno essere i seguen-
ti identificativi VID/PID che sono fondamentali per la corretta comunicazione con il soft-
ware su PC.

6.2 Taratura

Dopo che la periferica è st ata riconosciut a dal
sistema operativo, è possibile procedere con la
taratura del dispositivo mediante l’utilizzo di un
comune multimetro. Collegare i punt ali dello stru-
mento (impostato per la misurazione di tensioni in
continua) ai terminali siglati TP (+) e (GND) (vedi
immagine a fianco). 
Mediante l’uso di un cacciavite a t aglio, regolare il
trimmer R1 per ottenere una tensione di 13,5 V . 
Il dispositivo è ora pronto per essere utilizzato.

Terminale TP Terminale 
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7. INSTALLAZIONE DEL SOFTWARE PICKit2

Questo programmatore è comp atibile con il sof tware di programmazione Microchip PICKit2 
ver. 1.20 (scaricabile gratuitamente dal sito www.microchip.com) ad eccezione della funzione di
aggiornamento diretto del firmware e di programmazione della famiglia PIC 18FJ. 

Nota: firmware e sof tware originali non prevedono (gia' per conto loro) la programmazione delle
memorie I2C.

Lanciare il file di setup PICkit 2 setup.EXE per avviare la procedura d’inst allazione del program-
ma. Dopo aver ef fettuato l'installazione seguendo le facili istruzioni a video, basterà fare doppio
clic sull'icona relativa per avviare il programma PICkit 2; comparirà la finestra sotto riportata (test
con un 16F876A inserito).
Nota: si faccia attenzione che avviando il software con programmatore inserito deve comparire la
versione firmware (cerchiata in rosso nell’esempio).  

Batta dei menu

Finestra 
configurazione

dispositivo

Program 
Memory

Data EEPROM
Memory

Barra di stato

Barra di avanzamento
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In questo programmatore la funzione di aggiornamento diretto del firmware non è disponibile. 

Se si seleziona la relativa voce come nella figura seguente:

si riceverà in rispost a il seguente errore dovuto al fatto che la basett a è sprovvista di memoria,
pertanto si è reso necessario effettuare una simulazione di scrittura rispondendo opportunamen-
te ai controlli del software per evitarne il blocco.

Il sistema continuerà a funzionare corrett amente anche dopo quest a operazione fittizia. 
Se si esegue il comando Tools-> Check-Board, si potrà notare che la versione del firmware rima-
ne sempre la stessa, come si vede nell'immagine seguente.
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7.1. Barra dei menu

Tramite i menu presenti nella “Barra dei menu”, è possibile accedere alle funzioni del program-
ma di seguito elencate:

FILE
Import File: importa il file .hex che si vuole programmare nel dispositivo. 
Export File: esporta il file .hex memorizzato nel dispositivo.
Exit: esce dal programma.

DEVICE FAMILY
Baseline (12-bit Core):  configura il software per l’utilizzo con dispositivi a 12 bit.
Mid-range (14-bit Core): configura il software per l’utilizzo con dispositivi a 14 bit.
PIC18F: configura il software per l’utilizzo con dispositivi PIC18F Flash. 
PIC18J: configura il software per l’utilizzo con dispositivi PIC18FXXJXX 

Flash (attualmente non disponibile).
dsPIC: configura il sof tware per l’utilizzo con dispositivi dsPIC Flash 

(attualmente non displonibile).
PROGRAMMER
Read Device: legge la Program Memory , la Dat a EEPROM Memory , 

l’ID locations e la configuration bit s.
Write Device: scrive nella Program Memory, nella Data EEPROM Memory, 

l’ID locations e la configuration bit s.
Verify: confronta i dati implementati nel dispositivo con quelli presenti nel

buffer di memoria del programma. 
Erase: cancella complet amente il contenuto del dispositivo 

(tranne OSCCAL e BG; solo PIC12F629/675 e PIC16F630/676).
Blank Check: verifica che nel dispositivo non vi sia implement ato alcun dato.
Full Erase: cancella complet amente il contenuto del dispositivo 

(compresi OSCCAL e BG; solo PIC12F629/675 e PIC16F630/676).
Regenerate OSCCAL: rigenera il valore OSCCAL (solo per PIC12F629/675 e PIC16F630/676);

la linea AUX deve essere connessa al pin RA4/T1G (non disponibile)
Set Band Gap Calibration Value: imposta il valore BG (solo per PIC12F629/675 e PIC16F630/676).

TOOLS
Code-Protect Device: abilita una protezione che non permette la lettura del dispositivo.
Target Power: alimentazione fornita dal programmatore.
Check Board: verifica la comunicazione con il programmatore e legge l’ID del 

dispositivo.  
Download PICkit 2 Operating
System: permette di eseguire l'aggiornamento diretto del firmware 

(non disponibile)

HELP
About: mostra versione e data del software.
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7.2. Finestra configurazione del dispositivo

In questa finestra viene indicato il tipo di dispositivo inserito nello zoccolo del programmatore, il
relativo ID, la configuration Word e il Checksum. Con i PIC12F629/675 e PIC16F630/676 vengo-
no indicati anche OSCCAL e Band Gap.
Se vengono utilizzati dispositivi a 12 bit, l’utente deve selezionare il tipo desiderato tra quelli pre-
senti nel menu a tendina “Device”, mentre se i dispositivi rientrano nella categoria a 14 bit,
PIC18F, questi vengono rilevati automaticamente dal programmatore.

7.3. Barra di stato

Questa barra fornisce indicazioni circa lo st ato delle operazioni in esecuzione. Se l’operazione
viene eseguita con successo, lo sfondo di t ale barra si colora di verde, se invece si è verificato
un errore, lo sfondo si colora di rosso. 
In caso di messaggi d’avvertimento, la barra si colora di giallo.

7.4. Barra di avanzamento

Indica lo stato di avanzamento di un processo.

7.5. Program Memory

Un file .HEX può essere import ato tramite il comando File >Import HEX o letto dirett amente dal
dispositivo collegato al programmatore cliccando sul pulsante “Read”. L’origine del file viene indi-
cata nel campo “Source”.
La finestra “Program Memory” visualizza il program code in formato esadecimale.
Se il check box posto a fianco della finestra Program Memory viene fleggato, il contenuto della
finestra verrà trasferito nella Program Memory del dispositivo che si vuole programmare e verrà
utilizzato per la verifica al termine della programmazione, mentre se non viene fleggato, il conte-
nuto della finestra, non verrà trasferito nel dispositivo e quindi non potrà essere utilizzato per la
verifica. 

7.6. Data EEPROM Memory

Come già detto per il Program Memory, un file .HEX può essere importato tramite il comando File
>Import HEX o letto dirett amente dal dispositivo collegato al programmatore cliccando sul pul-
sante “Read”. L’origine del file viene indicata nel campo “Source”.
La finestra “Data EEPROM Memory” visualizza il program code in formato esadecimale. 
Se il check box posto a fianco della finestra Dat a EEPROM Memory viene fleggato, il contenuto
della finestra verrà trasferito nella memoria EEPROM del dispositivo che si vuole programmare
e verrà utilizzato per la verifica al termine della programmazione, mentre se non viene fleggato,
il contenuto della finestra, non verrà trasferito nel dispositivo e quindi non potrà essere utilizzato
per la verifica. 
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8. UTILIZZO DEL PROGRAMMATORE

Collegare al proprio PC il programmatore (l’accensione del LED verde indica che il dispositivo è st ato
riconosciuto dal sistema). Inserire nell’idoneo zoccolo il dispositivo che si vuole programmare e avvia-
re il programma PICkit 2. Nota: nelle pag. 18, 19 e 20 sono riportate indicazioni utili per il corretto inse-
rimento dei vari dIspositivi nello zoccolo textool ed anche la pin out relativa al connettore per la pro-
grammazione in-circuit.

1. Selezione Device Family
Selezionare dal menu Device Family la famiglia di app artenenza del dispositivo utilizzato.

Se è stata selezionata la voce Mid-range (14-bit core) o PIC18F, il programmatore rileverà auto-
maticamente il dispositivo indicando nella finestra configurazione, tutte le relative informazioni.

Se invece è st ata selezionata la voce Baseline (12-bit core), l’utente dovrà selezionare il tipo
desiderato tra quelli presenti nel menu a tendina “Device”.

Attenzione: assicurarsi che il dispositivo selezionato corrisponda con quello da programmare! 
Una selezione errata del dispositivo causa la cancellazione del valore OSCCAL memorizzato.

2. Target Power
Normalmente il circuito fornisce al pin Vdd una tensione di 5 V solo durante la fase di program-
mazione; se si desidera mantenere in modo permanente quest a tensione, è necessario fleggare
la voce Target Power come mostrato nella figura seguente:
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3. Importazione del file .HEX
Per importare un file con estensione .HEX, selezionare la voce File > Import HEX come mostra-
to nella figura seguente:

Selezionare il file desiderato quindi premere OK; il file, in formato esadecimale, verrà visualizza-
to nelle finestre Program Memory e EE Dat a Memory, mentre il nome del file verrà indicato nel
campo Source. 

4. Scrittura dei dati
Dopo aver selezionato la famiglia di appartenenza ed aver importato il file .HEX, è possibile pro-
cedere con la programmazione del dispositivo agendo sul pulsante “W rite”. Lo stato dell'opera-
zione di scrittura viene mostrato nella barra di st ato.
Se l’operazione viene eseguita con successo, lo sfondo di tale barra si colora di verde ed app a-
re la scritta “Write Successful”, 

se invece si è verificato un errore, lo sfondo si colora di rosso ed app are la scritta “Verify failed”;
in questo caso eseguire nuovamente l’operazione.

5. Verifica dei dati scritti
Questa funzione permette di confrontare tutti i dati implementati nel dispositivo con quelli del file
.HEX importato. Per eseguire l’operazione, import are il relativo file .HEX e premere il pulsante
“Verify”. Se il codice implement ato nel microcontrollore è identico a quello import ato, la barra di
stato si colora di verde ed app are la scritt a “Device Verified”, altrimenti se viene riscontrato un
errore, si colora di rosso ed appare la scritta “Error in Program Memory, Data EEPROM Memory,
or Configuration Bits”.
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6. Lettura dei dati
Per leggere i dati implement ati nel microcontrollore, premere il pulsante “Read”. I dati vengono
visualizzati nelle finestre Program Memory e Dat a EEPROM Memory. Se dovessero comp arire
solamente degli “0000”, significa che il dispositivo è protetto da lettura.

7. Attivazione Code-Protect Device
Questa funzione, se attivata, permette di proteggere da lettura i dati implement ati nel microcon-
trollore. 
Per attivarla procedere come di seguito descritto:
a. Importare il file HEX
b. selezionare Tools > Code Protect Device, come mostrato dall’immagine seguente:

c. Premere il pulsante “Write” 

8. Cancellazione 
La funzione “Erase” permette di eseguire la cancellazione dell’ID, della configuration bit s, della
Program Memory e della Data EEPROM Memory. 
Questa operazione viene eseguita in automatico dal programmatore prima di ogni scrittura. 
Per cancellare un dispositivo, premere il t asto “Erase”.

Nota: l’accensione del LED rosso indica che è in corso l’esecuzione di un’operazione.

8.1. Informazioni importanti

Il dispositivo deve essere impiegato esclusivamente per l’uso per il quale è st ato concepito.
In nessun caso l’azienda Futura Elettronica, o i rispettivi rivenditori, saranno ritenuti responsabi-
li per qualsiasi tipo di danno, straordinario, accident ale o indiretto di qualsiasi natura (economi-
ca, fisica ecc...), derivante dal possesso, dall’uso o dal guasto del presente prodotto; lo stesso
dicasi per danni derivanti da un utilizzo improprio del dispositivo.
La garanzia decade in caso di modifiche o manomissioni dell’app arecchio o qualora non vengano
rispettate le indicazioni riportate nel presente manuale. 
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9. POSIZIONAMENTO DEI MICRO SULLA SCHEDA ZOCCOLO TEXTOOL (FT652)

Pe poter programmare un chip è necessario che questo venga inserito corrett amente nello zoc-
colo textool (la figura sotto riportata mostra l’orientamento della tacca). 
Sulla scheda FT652 è riport ata una serigrafia che indica l’esatto posizionamento del dispositivo
a seconda del numero dei pin  (8 pin, 14, 18, 28 e 40).

FT652

Connettore di 
programmazione

OUT

Connettore di 
programmazione

IN
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10. POSIZIONAMENTO DEI MICRO SULLA SCHEDA ZOCCOLI (FT651)

Per programmare un chip utilizzando la scheda FT651 bast a inserire il dispositivo nello zoccolo
corrispondente rispettando la tacca di orientamento.
Il numero dei pin di ciascuno zoccolo è indicato dalla serigrafia riport ata sulla scheda. 
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Le informazioni contenute nel presente manuale possono essere soggette a variazioni senza
alcun preavviso.

Realizzato da:
FUTURA ELETTRONICA Via Adige, 11
21013 Gallarate (VA) Tel. 0331-799775 Fax. 0331-792287

Aggiornamento: 01/10/2009

11. PROGRAMMAZIONE IN-CIRCUIT 

Se deve essere eseguita una programmazione in-circuit, collegare il connettore maschio del flat
cable, opportunamente cablato (vedi p aragrafo 5.3), al connettore di programmazione dell’unità
principale o di un’espansione e il connettore femmina alla scheda su cui è mont ato il chip, utiliz-
zando le linee necessarie alla programmazione (CLK, DAT, GND, Vpp e Vdd).

Informazioni ambientali relative al presente prodotto 
Questo simbolo riportato sul prodotto o sull’imballaggio, indica che è vietato smaltire il prodotto nel-
l’ambiente al termine del suo ciclo vit ale in quanto può essere nocivo per l’ambiente stesso. 
Non smaltire il prodotto (o le pile utilizzate) come rifiuto indif ferenziato; rivolgersi ad un’impresa
locale specializzata nel riciclaggio.
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